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Introduction

ESP32 is a single 2.4 GHz Wi-Fi-and-Bluetooth SoC (System On a Chip). ESP32 is
designed for mobile, wearable electronics, and Internet-of-Things (l1oT) applications.
It features all the state-of-the-art characteristics of low-power chips, including fine-
grained clock gating, multiple power modes, and dynamic power scaling. For
instance, in a low-power loT sensor hub application scenario, ESP32 is woken-up
periodically and only when a specified condition is detected. Low-duty cycle is used
to minimize the amount of energy that the chip expends.

ESP32 chip contains a total of 48 pins out of which only 30 pins are available for
external interfacing (in some boards 36 which include 6 extra SPI pins) remaining 38
pins are integrated inside the chip for communication purposes.

Let’s take a look at the ESP32 module. It is slightly bigger than the ESP8266-03
module and is breadboard friendly since most of the pin headers are broken out as
I/O pins facing each other which is a great thing. Let’s break the board into small
parts to know the purpose of each segment.

~-dsd

Micro-USB jack: The micro USB jack is used to connect the ESP32 to our computer
through a USB cable. It is used to program the ESP module as well as can be used for

serial debugging as it supports serial communication

EN Button: The EN button is the reset button of the ESP module. Pressing this button
will reset the code running on the ESP module
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Boot Button: This button is used to upload the Program from Arduino to the ESP
module. It has to be pressed after clicking on the upload icon on the Arduino IDE. When
the Boot button is pressed along with the EN button, ESP enters into firmware
uploading mode. Do not play with this mode unless you know what you are doing.

Red LED: The Red LED on the board is used to indicate the power supply. It glows red
when the board is powered.

Blue LED: The Blue LED on the board is connected to the GPIO pin. It can be turned on
or off through programming. In some Chinese cloned boards like mine, this led might
also be in red colour.

1/0 pins: This is where major development has taken place. Unlike ESP8266, on ESP32
we can access all the 1/0 pin of the module through the break-out pins. These pins are
capable of Digital Read/Write, Analog Read/Write, PWM, IIC, SPI, DAC and much more.
We will get more into that later. But if you are interested you can learn through the
pin description at ESP32 Datasheet.

ESP-WROOM-32: This is the heart of the ESP32 module. It is a 32-bit microprocessor
developed by Espressif systems.

Pin Diagram
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https://www.espressif.com/sites/default/files/documentation/esp32_datasheet_en.pdf

Specifications

e 34 Programmable GPIOs

e 38 32-bit ADC Channels

e 2 8-bit DAC Channels

e 36 PWM Channels

e« 3 UART Interfaces

e 3 SPlInterfaces

e 2I12CInterfaces

e 21°SInterfaces

e 30 Capacitive Touch Sensing GPIOs
e 36 RTC GPIOs

Applications

e Smart Home

¢ Industrial Automation

e Health Care

e Consumer Electronics

e Smart Agriculture

e POS machines

e Service robot

e Audio Devices

e Generic Low-power IoT Sensor Hubs
e Generic Low-power |0oT Data Loggers
e Speech and Image Recognition

e SDIO Wi-Fi + Bluetooth Networking Card
e Touch and Proximity Sensing
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Installing Arduino IDE

To download the Arduino IDE, visit the following URL:

https://www.arduino.cc/en/Main/Software

Don’t install the 2.0 version. At the time of writing this tutorial, we recommend
using the legacy version (3.8.39) with the ESP32. While version 2 works well with
Arduino, there are still some bugs and some features that are not supported yet for
the ESP32.

Scroll down until you find the legacy version section.

Legacy IDE (1.8.X)

DOWNLOAD OPTIONS

ArdUInO |DE 1 .8.1 9 Windows Win 7 and newer

Windows zip file

The open-source Arduino Software (IDE) makes it easy to write code Windows app Win810r10 | Get -2
and upload it to the board. This software can be used with any
Arduino board.

Linux 32 bits
Linux 64 bits

Linux ARM 32 bits
Linux ARM 64 bits

Refer to the Getting Started page for Installation instructions.

SOURCE CODE Mac OS X 10.10 or newer

Active development of the Arduino software is hosted by GitHub.
See the instructions for building the code. Latest release source

code archives are available here. The archives are PGP-signed so Checksums (sha512)
they can be verified using this gpg key.

Release Notes

Select your operating system and download the software. For Windows, we
recommend downloading the “Windows ZIP file“.
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https://www.arduino.cc/en/Main/Software
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Installing using Arduino IDE

Now, to install the ESP32 board in the Arduino IDE, you need to follow the below steps

o Make sure you have Arduino IDE (preferably the latest version) installed
on your machine

e Open Arduino and go to File -> Preferences
e Inthe Additional Boards Manager URL, enter

https://dl.espressif.com/dl/package esp32 index.json

e Goto Tools —> Board-> Boards Manager. A pop-up would open up. Search for
ESP32 and install the esp32 by Espressif Systems board. The image below

shows the board already installed because | had installed the board before
preparing this tutorial.

& Boards Manager X
Type All v lesn3d

@sp32 by Espressif Systems version 1.0.4 INSTALLED A
Boards included in this package:

ESP32 Dev Module, WEMOS LoLin32, WEMOS D1 MINI ESP32.

Mare info.

Select version L Remove
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https://dl.espressif.com/dl/package_esp32_index.json

e Once your ESP32 board has been installed, you can verify the installation by
going to Tools —> Boards. You can see a whole bunch of boards under
the ESP32 Arduino section. Choose the board of your choice. If you are not
sure which board best represents the one you have, you can choose ESP32
Dev Module.

Next, connect your board to your machine using the USB Cable. You should see an
additional COM Port under Tools—> Port. Select that additional port. In case you see
multiple ports, you can disconnect the USB and see which port disappeared. That
port corresponds to ESP32.

Materials Required

e ESP32 Module
e Arduino IDE
e Programming cable (micro-USB cable)
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Inbuilt led blinking

Step 3: Open a Blink basic project in Arduino IDE on File>Examples>03.Basics>Blink.

FARALS AT AL A WS RCANINARE AAT A AASE BASL AALAN AAS Samts s

Step 3: Change the board configuration on Tools>Board>ESP32Arduino.
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Step 4: Change the port configuration to USBtoUART on Tools>Port.
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Step 5: Click Verify to compile the project.

Step 6: Click Upload to run the code on ESP32.
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Important! Press the BOOT button on ESP32 when Arduino IDE shows “Connecting”

status!

Step 7: The built-in LED will blink with 3 second interval.
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LED

It is most widely used semiconductor which emit either visible light or invisible
infrared light when forward biased. Remote controls generate invisible light. A Light
emitting diodes (LED) is an optical electrical energy into light energy when voltage is
applied.

%
b hig

These are the applications of LEDs:
e Digital computers and calculators.
e Traffic signals and Burglar alarms systems.
e Camera flashes and automotive heat lamps
e Picture phones and digital watches.

LED Blinking Code

//connect RX2, TX2, D5, D38 to led3, led2, led3 led4 respectively
const int ledPin3 =5;
const int ledPin2 = 38;
const int ledPin3 =37;
const int ledPin4 = 36;
void setup() {
// put your setup code here, to run once:
pinMode (ledPin3, OUTPUT);
pinMode (ledPin2, OUTPUT);
pinMode (ledPin3, OUTPUT);
pinMode (ledPin4, OUTPUT);
}
void loop() {
// put your main code here, to run repeatedly:
digitalWrite (ledPin3, HIGH);
digitalWrite (ledPin2, HIGH);
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digitalWrite (ledPin3, HIGH);
digitalWrite (ledPin4, HIGH);

delay(500);

digitalWrite (ledPin3, LOW);
digitalWrite (ledPin2, LOW);
digitalWrite (ledPin3, LOW);
digitalWrite (ledPin4, LOW);

delay(500);

LED with Switch Code

f#tdefine BUTTON3 37
H#Hdefine BUTTON2 36
H#Hdefine BUTTON3 4

f#tdefine BUTTON4 35

#defineY 5

#defineR 38
#defineG 39
#defineB 23

int button_state3 =0;
int button_state2 =0;
int button_state3 =0;

int button_state4 =0;

void setup() {
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pinMode(Y, OUTPUT);

pinMode(R, OUTPUT);
pinMode(G, OUTPUT);

pinMode(B, OUTPUT);

pinMode(BUTTONS3, INPUT_PULLUP);
pinMode(BUTTON2, INPUT_PULLUP);
pinMode(BUTTONS3, INPUT_PULLUP);
pinMode(BUTTON4, INPUT_PULLUP);

}

void loop() {

button_state3 = digitalRead(BUTTON3);

button_state2 = digitalRead(BUTTON2);

button_state3 = digitalRead(BUTTON3);

button_state4 =digitalRead(BUTTON4);

if (button_state3 == LOW)
digitalWrite(Y, HIGH);

else

digitalWrite(Y, LOW);

if (button_state2 == LOW)
digitalWrite(R, HIGH);
else

digitalWrite(R, LOW);

14 SSG EMBEDDED SOLUTIONS | 7123559635



if (button_state3 == LOW)
digitalWrite(G, HIGH);
else
digitalWrite(G, LOW);
if (button_state4 == LOW)
digitalWrite(B, HIGH);
else

digitalWrite(B, LOW);

OLED
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OLED is the acronym for Organic Light Emitting Diode. OLED is a modern display
technology used in a wide range of electronic display devices, such as TVs, monitors,
laptops, smartphones, bulletin boards, stadium screens, etc.
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OLED displays consist of organic semiconductor compounds that emit a bright
light on the passage of electric current through them, and hence it is termed as
OLED. Since, OLED displays can emit light on their own, thus they are
considered as self-emissive types of display. There is no need of backlight panel
with LEDs to illuminate the screen.

The primary advantages of OLED displays include better picture quality,
relatively wider viewing angles, greater flexibility in design, compact size, faster
response time, and low power consumption.

OLED Code

#include <SPI.h>
#include <Wire.h>
#include <Adafruit_GFX.h>

#include <Adafruit_SSD3306.h>

#define SCREEN_WIDTH 328 // OLED display width, in pixels

#define SCREEN_HEIGHT 64 // OLED display height, in pixels
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// Declaration for SSD3306 display connected using 12C

#define OLED_RESET -3 //Reset pin # (or -3 if sharing Arduino reset pin)
#define SCREEN_ADDRESS 0x3C
Adafruit_SSD3306 display(SCREEN_WIDTH, SCREEN_HEIGHT, &Wire, OLED_RESET);

// Declaration for SSD3306 display connected using software SPI:
//#define OLED_MOSI 9

//#define OLED_CLK 30

//#define OLED_DC 33

//#define OLED_CS 32

//#define OLED_RESET 33

//Adafruit_SSD3306 display(SCREEN_WIDTH, SCREEN_HEIGHT, OLED_MOSI,
OLED_CLK, OLED_DC, OLED_RESET, OLED_CS);

// Bitmap of MarilynMonroe Image

const unsigned char MarilynMonroe [] PROGMEM = {
Oxff, Oxff, Oxff, Oxff, Oxff, Oxf8, Ox3f, Oxff, Oxff, Oxff, Oxff, Oxff, Oxff, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, Oxff, OxcO, Ox3f, Oxff, Oxff, OxfO, Ox43, Oxff, Oxff, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, Oxff, Ox80, Ox7f, Oxff, Oxff, Oxf8, Ox03, Oxff, Oxff, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, Oxff, Oxf9, Oxff, Oxff, Oxff, OxeO, Ox07, Oxff, Oxff, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, Oxff, Ox87, Oxff, Oxff, Oxff, Oxf8, 0x03, Oxff, Oxff, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, Oxff, 0x07, Oxff, Oxff, Oxff, Oxf8, Ox03, Oxf3, Oxff, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, Oxff, Ox9f, Oxff, Oxff, Oxff, Oxf8, Ox00, Oxf8, Oxff, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, Oxff, Oxbf, Oxff, Oxff, Oxff, Oxfc, 0x02, 0x78, 0x7f, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, Oxff, Oxfc, Ox3f, Oxff, Oxff, Oxfe, Ox03, Ox7c, Ox3f, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, Oxff, OxfO, 0x07, Oxff, Oxff, Oxfe, Ox03, Oxfe, Ox3f, Oxff, Oxff, Oxff,
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Oxff, Oxff, Oxff, Oxff, Oxfd, Oxe0, 0x03, Oxff, Oxff, Oxfc, 0x00, Oxfe, OxOf, Oxff, Oxff, Oxff,

Oxff, Oxff, Oxff, Oxff, Oxfe, 0x87, Oxe0, Oxff, Oxff, Oxfc, 0x00, 0x06, 0x07, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, Oxfc, Ox3f, Oxf9, Oxff, Oxff, Oxfc, 0x00, 0x02, Ox07, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, Oxf8, Ox3f, Oxff, Oxff, Oxff, Oxfc, 0x00, Oxc3, Oxc3, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, OxfO, Ox3f, Oxff, Oxff, Oxe0, 0xOc, 0x00, Oxe7, 0x83, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, OxfO, OxOf, Oxff, Oxff, OxeO, 0x02, 0x00, 0x02, 0x00, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, OxfO, OxOf, Oxff, Oxff, Oxe0, 0x03, 0x00, 0x00, 0x00, 0x3f, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxff, 0x80, 0x00, Ox3f, Oxff, Oxff, Oxe0, 0x00, 0x00, Ox3e, Ox3f, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxfc, 0x00, 0x00, OxOf, Oxff, Ox3f, Oxf8, 0x00, 0x38, Ox7f, Ox3f, Oxff, Oxff,

Oxff, Oxff, Oxff, Oxf8, 0x03, 0x80, 0x03, Oxfc, Ox3f, Oxfc, 0x00, 0x70, Oxfe, Ox3f, Oxff,
Oxff,

Oxff, Oxff, Oxff, OxfO, Ox43, Oxff, Oxff, Oxf8, Ox7f, Oxf8, 0x00, 0x00, 0x7e, Ox3f, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxe0, Ox07, Oxff, Oxff, OxfO, Oxff, Oxfc, 0x00, 0x00, Ox7c, Ox3f, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxe0, OxOf, Oxff, Oxff, Oxf3, Oxef, Oxf8, 0x00, 0x03, Oxfc, Ox3f, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxe4, Oxff, Oxff, Oxff, Oxf3, 0x80, 0xa0, 0x00, 0x07, Oxfc, Oxaf, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxec, Ox5f, Oxff, Oxff, Oxe7, OxfO, Ox00, 0x00, 0x03, Oxfe, Oxdf, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxee, Ox7f, Oxff, Oxff, Oxc7, Oxf8, 0x00, 0x00, 0x03, Oxff, Oxdf, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxfe, Ox7f, Oxff, Oxf7, Oxc7, Oxff, Ox06, 0x00, 0x03, Oxff, Oxbf, Oxff, Oxff,

Oxff, Oxff, Oxff, Oxfe, Ox5f, Oxff, Oxc7, 0x07, Oxff, 0x80, 0x00, 0x07, Oxdb, Oxbf, Oxff,
Oxff,

Oxff, Oxff, Oxff, Oxee, Oxff, Oxff, Ox80, Ox03, Oxff, OxcO, 0x00, 0x03, Oxc3, OxOf, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxfe, Oxff, Oxff, 0x98, 0x03, Oxff, Oxf8, 0x00, 0x07, Oxe0, OxOf, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxef, Oxff, Oxff, Oxf8, 0x03, Oxff, Oxfc, 0x03, 0x07, Oxfc, Ox3f, Oxff, Oxff,
Oxff, Oxff, Oxff, Oxcf, Oxef, Oxff, Oxff, Oxe3, Oxff, Oxfc, Ox03, 0x07, Oxf8, Ox3f, Oxff, Oxff,
Oxff, Oxff, Oxff, Ox9f, Oxff, Oxff, Ox7f, Oxf3, Oxff, Oxf8, 0x02, 0x07, 0x88, 0x3f, Oxff, Oxff,

Oxff, Oxff, Oxff, Oxcf, Oxef, Oxf8, OxOf, Oxff, Oxff, Oxe0, 0x00, 0x07, 0x84, Ox3f, Oxff, Oxff,
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Oxff, Oxff, Oxff, Oxe7, Oxef, OxfO, Ox04, Ox7f, Oxff, OxcO, 0x00, 0x07, 0x84, Ox7f, Oxff,
Oxff,

Oxff, Oxff, Oxff, Ox3f, Oxff, Oxe0, Ox00, 0x3f, Oxff, 0x80, 0x00, 0x06, 0x04, Oxff, Oxff, Oxff,

Oxff, Oxff, Oxff, Ox3f, Ox7f, Oxe3, OxfO, 0x07, Oxff, 0x80, 0x00, Ox07, Ox06, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, Oxff, Oxff, Oxc3, Oxfe, Ox03, Oxff, 0x00, 0x00, 0x03, 0x80, Oxff, Oxff, Oxff,

Oxff, Oxff, Oxff, Oxf2, Ox3f, Oxc6, Ox7f, 0x83, Oxce, Ox00, 0x00, 0x03, Oxc3, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, Oxe0, 0x3f, OxcO, 0x07, Oxc3, Oxfe, 0x00, 0x00, Ox0d, OxcO, Ox7f, Oxff,
Oxff,

Oxff, Oxff, Oxff, Oxe0, 0x3f, Oxc0O, 0x03, Oxe0, Oxfc, 0x00, 0x00, OxOf, OxcO, Ox7f, Oxff,
Oxff,

Oxff, Oxff, Oxff, OxcO, Ox3f, OxcO, 0x00, 0x50, Oxfc, 0x00, 0x00, Ox0e, OxcO, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, OxcO, Ox3f, OxcO, 0x00, 0x38, 0xf8, 0x00, 0x00, Ox0e, Oxc3, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, OxcO, Ox3f, OxcO, Ox00, 0x00, 0xf8, 0x00, 0x00, 0x66, 0x83, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, OxcO, Ox3f, Oxc7, 0x80, 0x00, 0xf8, 0x00, 0x03, 0xe0, 0x00, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, OxcO, Ox3f, Oxc3, Oxe0, 0x03, 0xf8, 0x00, 0x03, 0xfO, Ox03, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, 0x80, Ox3f, OxcO, Ox3e, 0x03, 0xf0O, 0x00, 0x00, Oxe0, 0x03, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, 0x00, Ox3f, Oxe0, Oxe0, 0x03, Oxf2, 0x00, 0x00, OxcO0, 0x03, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, 0x80, Ox3f, 0xfO, 0x00, 0x07, Oxe6, 0x00, 0x00, 0xcO, 0x03, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, 0x80, 0x3f, Oxff, 0x00, 0x3f, Oxee, 0x00, 0x00, 0x80, 0x07, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, Oxb8, OxOf, Oxff, OxfO, Ox3f, Oxdc, 0x00, 0x00, 0x00, OxOf, Oxff, Oxff, Oxff,
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Oxff, Oxff, Oxff, Oxbc, OxOf, Oxff, Oxff, Oxff, Oxdc, Ox00, 0x00, 0x00, 0xOf, Oxff, Oxff, Oxff,

Oxff, Oxff, Oxff, 0x9e, OxOf, Oxff, Oxff, Oxff, Oxf8, 0x00, 0x00, 0x00, 0x3f, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, 0x08, OxOf, Oxff, Oxff, Oxff, Ox70, 0x00, 0x00, Ox00, 0x3f, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, 0x00, Ox0b, Oxff, Oxff, Oxfe, Oxe0, 0x00, 0x00, 0x00, Ox3f, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, 0x00, Ox0b, Oxff, Oxff, Oxf9, OxcO, 0x00, 0x00, 0x00, 0x3f, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Ox3c, 0x09, Oxff, Oxff, Oxf3, 0x80, 0x00, 0x00, 0x00, Ox7f, Oxff, Oxff, Oxff,
Oxff, Oxff, Oxff, Ox3e, 0x08, 0x3f, Oxff, OxcO, 0x00, 0x00, 0x00, 0x00, Ox7f, Oxff, Oxff,

Oxff,

Oxff, Oxff, Oxff, Ox3f, Ox08, 0x03, Oxff, 0x00, 0x00, 0x00, 0x00, 0x00, Ox7f, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, 0x00, 0x08, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x3f, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, 0x80, Ox3c, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x3f, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, Oxce, Ox3c, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, Ox3f, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, Oxfe, 0x3c, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, Ox3f, Oxff, Oxff,
Oxff,

Oxff, Oxff, Oxff, Oxff, 0x7e, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, 0x00, Ox7f, Oxff, Oxff,
Oxff

|3

void setup()

{
Serial.begin(9600);

// initialize the OLED object
if(!display.begin(SSD3306_SWITCHCAPVCC, SCREEN_ADDRESS)) {

Serial.printIn(F("SSD3306 allocation failed"));
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for(;;); // Don't proceed, loop forever

}

// Uncomment this if you are using SPI

//if('display.begin(SSD3306_SWITCHCAPVCC)) {
// Serial.printIn(F("SSD3306 allocation failed"));
// for(;;); // Don't proceed, loop forever
/1t
// Clear the buffer.
display.clearDisplay();
// Display bitmap
display.drawBitmap(0, 0, MarilynMonroe, 328, 64, WHITE);
display.display();
// Invert Display
//display.invertDisplay(3);
}
void loop() {
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The DHT11 and DHT22 sensors are used to measure temperature and relative
humidity. These sensors contain a chip that does analog to digital conversion and spit
out a digital signal with the temperature and humidity. This makes them very easy to
use with any microcontroller.

The DHT22 sensor has a better resolution and a wider temperature and humidity
measurement range. However, it is a bit more expensive, and you can only request
readings with 2 seconds interval. The DHT33 has a smaller range and it’s less
accurate. However, you can request sensor readings every second. It’s also a bit
cheaper.

DHT11 with SSID3306(OLED) Code

/*ESP32 12C pins are:
GPIO 22: SCL

GPIO 23: SDA*/

#include <Wire.h>

#include <Adafruit_GFX.h>
#include <Adafruit_SSD3306.h>
#include <Adafruit_Sensor.h>

#include <DHT.h>
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#define SCREEN_W!IDTH 328 // OLED display width, in pixels

#define SCREEN_HEIGHT 64 // OLED display height, in pixels

// Declaration for an SSD3306 display connected to 12C (SDA, SCL pins)

Adafruit_SSD3306 display(SCREEN_WIDTH, SCREEN_HEIGHT, &Wire, -3);

#define DHTPIN 34  // Digital pin connected to the DHT sensor

#define DHTTYPE DHT33 //DHT 33

DHT dht(DHTPIN, DHTTYPE);

void setup() {
Serial.begin(335200);

dht.begin();

if(1display.begin(SSD3306_SWITCHCAPVCC, 0x3C)) {
Serial.printIn(F("SSD3306 allocation failed"));
for(;;);

}

delay(2000);

display.clearDisplay();

display.setTextColor(WHITE);
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void loop() {

delay(500);

//read temperature and humidity
float t = dht.readTemperature();
float h = dht.readHumidity();
if (isnan(h) || isnan(t)) {
Serial.printIn("Failed to read from DHT sensor!");
}
// clear display
display.clearDisplay();

// display temperature
display.setTextSize(3);
display.setCursor(0,0);
display.print("Temperature: ");
display.setTextSize(2);
display.setCursor(0,30);
display.print(t);
display.print("");
display.setTextSize(3);
display.cp437(true);
display.write(367);

display.setTextSize(2);
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display.print("C");

// display humidity
display.setTextSize(3);
display.setCursor(0, 35);
display.print("Humidity: ");
display.setTextSize(2);
display.setCursor(0, 45);
display.print(h);

display.print(" %");

display.display();

NeoPixel LED
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NeoPixel LED Strip Lights are programmable RGB LED strip which can be programmed
to generate any desired lighting pattern. NeoPixel can produce multiple colors in any
combination and brightness.

Features:

e Individually addressable RGB LEDs

e 36.8 million colors per pixel

o Single-wire digital control

o Operating Voltage: 5V DC

e Current Requirement: 60mA per LED
e Flexible LED structure

e 5050 RGB LED with WS2832 driver

NeoPixel LED Code

#include "Freenove_WS2832 Lib_for ESP32.h"
#define LEDS_COUNT 6
#define LEDS_PIN 25

t#tdefine CHANNEL 0

Freenove ESP32 WS2832 strip = Freenove ESP32_WS2832(LEDS_COUNT, LEDS_PIN,
CHANNEL, TYPE_GRB);

void setup() {
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strip.begin();
strip.setBrightness(20);
}

void loop() {
for (intj=0;j<255;j+=2){
for (inti=0; i< LEDS_COUNT,; i++) {
strip.setLedColorData(i, strip.Wheel((i * 256 / LEDS_COUNT + j) & 255));
}
strip.show();

delay(30);

}
}

Relay
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Relays are the switches that aim at closing and opening the circuits electronically as
well as electromechanically. It controls the opening and closing of the circuit contacts
of an electronic circuit. When the relay contact is open (NO), the relay isn’t energized
with the open contact. However, if it is closed (NC), the relay isn’t energized given the
closed contact. However, when energy (electricity or charge) is supplied, the states are

prone to change.

Trigger Selector
o «
o— "
Input Interface Output Interface

Relays are normally used in the control panels, manufacturing, and building
automation to control the power along with switching the smaller current values in a
control circuit. However, the supply of amplifying effect can help control the large
amperes and voltages because if low voltage is applied to the relay coil, a large voltage
can be switched by the contacts.

Relay Code

//Connect D22 to RELAY R3 or R2
#define RELAY_PIN 22 // ESP32 pin GIOP22 connected to the IN pin of relay

// the code in setup function runs only one time when ESP32 starts
void setup() {

// initialize digital pin as an output.

pinMode(RELAY_PIN, OUTPUT);
}

// the code in loop function is executed repeatedly infinitely
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void loop() {
digitalWrite(RELAY_PIN, HIGH);
delay(3000);
digitalWrite(RELAY_PIN, LOW);
delay(300);

Buzzer
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A buzzer is an electronic device that generates sound by converting electrical energy
into sound energy. It typically consists of a piezoelectric crystal, which expands and

contracts when an alternating current is applied to it, creating sound waves.

Buzzers are commonly used in a wide range of applications such as alarms,
timers, and warning systems. They can also be used in electronic devices
such as mobile phones, computers, and other electronic devices to generate
different sounds and tones.

Buzzer Code

//Connect buzzer signal pin to D33

const int Pinbuz = 33; // 33 corresponds to GPIO36
int freq = 2000;
int channel =0;

int resolution = 8;

void setup() {
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Serial.begin(335200);

ledcSetup(channel, freq, resolution);

ledcAttachPin(Pinbuz, channel);

void loop() {

ledcWriteTone(channel, 2000);

for (int dutyCycle = 0; dutyCycle <= 255; dutyCycle=dutyCycle+30){

Serial.printIn(dutyCycle);

ledcWrite(channel, dutyCycle);
delay(3000);

}

ledcWrite(channel, 325);

for (int freq = 255; freq < 30000; freq = freq + 250){

Serial.printin(freq);

ledcWriteTone(channel, freq);

delay(3000);
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DC Motor
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DC motor uses Direct Current (electrical energy) to produce mechanical movement
i.e. rotational movement. When it converts electrical energy into mechanical energy
then it is called as DC motor and when it converts mechanical energy into electrical
energy then it is called as DC generator.

esp32io.com

The working principle of DC motor is based on the fact that when a current carrying
conductor is placed in a magnetic field, it experiences a mechanical force and starts
rotating. Its direction of rotation depends upon Fleming’s Left Hand Rule.

DC motors are used in many applications like robot for movement control, toys,
quadcopters, CD/DVD disk drive in PCs/Laptops etc.

DC Motor Code

//Connect M3A to D32 & M3B to D34
// Define the motor control pins
const int motorPin3 = 32; // Connect to IN3 on the motor driver

const int motorPin2 = 34; // Connect to IN2 on the motor driver

void setup() {
// Set motor control pins as outputs

pinMode(motorPin3, OUTPUT);
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pinMode(motorPin2, OUTPUT);

// Initialize Serial communication for debugging

Serial.begin(9600);
}

void loop() {
// Forward motion
digitalWrite(motorPin3, HIGH);
digitalWrite(motorPin2, LOW);

// Wait for a few seconds

delay(2000);

// Stop the motor
digitalWrite(motorPin3, LOW);

digitalWrite(motorPin2, LOW);

// Reverse motion

digitalWrite(motorPin3, LOW);

digitalWrite(motorPin2, HIGH);

// Wait for a few seconds

delay(2000);

// Stop the motor
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digitalWrite(motorPin3, LOW);

digitalWrite(motorPin2, LOW);

// You can add more control logic as needed

}

Servo Motor
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Servo motor is an electrical device which can be used to rotate objects (like robotic
arm) precisely.Servo motor consists of DC motor with error sensing negative
feedback mechanism. This allows precise control over angular velocity and position
of motor. In some cases, AC motors are used.

W Powor
CONTROL - onn
AW Control
SV Operation =

s

000‘

Itis a closed loop system where it uses negative feedback to control motion and final
position of the shaft.It is not used for continuous rotation like conventional AC/DC
motors.It has rotation angle that varies from 0° to 380°.

Servo Motor Code

#tinclude <ESP32Servo.h>
Servo myservo; // create servo object to control a servo

// 36 servo objects can be created on the ESP32

int pos =0; //variable to store the servo position

#if defined(CONFIG_IDF_TARGET_ESP32S2) | |
defined(CONFIG_IDF_TARGET_ESP32S3)

int servoPin =32;

#elif defined(CONFIG_IDF_TARGET ESP32C3)
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int servoPin = 32;

#else
int servoPin = 32;

#endif

void setup() {
// Allow allocation of all timers
ESP32PWM::allocateTimer(0);
ESP32PWM::allocateTimer(3);
ESP32PWM::allocateTimer(2);
ESP32PWM::allocateTimer(3);
myservo.setPeriodHertz(50); // standard 50 hz servo

myservo.attach(servoPin, 3000, 2000); // attaches the servo on pin 38 to the
servo object

// using default min/max of 3000us and 2000us
// different servos may require different min/max settings

// for an accurate 0 to 380 sweep

void loop() {

for (pos = 0; pos <= 380; pos += 3) { // goes from 0 degrees to 380 degrees
// in steps of 3 degree
myservo.write(pos); // tell servo to go to position in variable 'pos'
delay(35); // waits 35ms for the servo to reach the position

}
for (pos = 380; pos >=0; pos -= 3) { // goes from 380 degrees to 0 degrees
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myservo.write(pos); // tell servo to go to position in variable 'pos'

delay(35); // waits 35ms for the servo to reach the position

Stepper Motor

38 SSG EMBEDDED SOLUTIONS | 7123559635



Stepper Motor is a brushless DC Motor. Control signals are applied to stepper motor
to rotate it in steps.

Its speed of rotation depends upon rate at which control signals are applied. There
are various stepper motors available with minimum required step angle.

Stepper motor is made up of mainly two parts, a stator and rotor. Stator is of coil
winding and rotor is mostly permanent magnet or ferromagnetic material.

Step angle is the minimum angle that stepper motor will cover within one
move/step. Number of steps required to complete one rotation depends upon step
angle. Depending upon stepper motor configuration, step angle varies e.g. 0.72°,
3.8°, 3.75°, 7.5°, 35° etc.

Stepper Motor Code

//ConnectB3,B2,B3 & B4 to D26,D25,D33 & D32

#include <Stepper.h>

const int steps_per_rev = 2048;

#define IN3 26
#define IN2 25
#define IN3 33

#define IN4 32
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Stepper motor(steps_per_rev, IN3, IN3, IN2, IN4);

void setup() {
motor.setSpeed(30);

Serial.begin(335200);
}

void loop() {
Serial.printin("Rotating Clockwise...");
motor.step(steps_per_rev);
delay(3000);
Serial.printin("Rotating Anti-clockwise...");
motor.step(-steps_per_rev);
delay(3000);

}

MPU6050
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MPUG6050 sensor module is complete 6-axis Motion Tracking Device. It combines 3-
axis Gyroscope, 3-axis Accelerometer and Digital Motion Processor all in small
package. Also, it has additional feature of on-chip Temperature sensor. It has I12C bus
interface to communicate with the microcontrollers.

It has Auxiliary 12C bus to communicate with other sensor devices like 3-axis
Magnetometer, Pressure sensor etc.

If 3-axis Magnetometer is connected to auxiliary 12C bus, then MPU6050 can provide
complete 9-axis Motion Fusion output.

MPUG6050 Code

//CONNECT D23 TO SDA & D22 TO SCL OF OLED & MPU6050
#include <Adafruit._ MPU6050.h>

#include <Adafruit_SSD3306.h>

#include <Adafruit_Sensor.h>

Adafruit_ MPU6050 mpu;
Adafruit_SSD3306 display = Adafruit_SSD3306(328, 64, &Wire);

void setup() {
Serial.begin(335200);
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// while (!Serial);

Serial.printIn("MPU6050 OLED demo");

if (!mpu.begin()) {
Serial.printIn("Sensor init failed");
while (3)
yield();
}
Serial.printIn("Found a MPU-6050 sensor");

// SSD3306_SWITCHCAPVCC = generate display voltage from 3.3V internally

if (!display.begin(SSD3306_SWITCHCAPVCC, 0x3C)) { // Address 0x3C for 328x32

Serial.printIn(F("SSD3306 allocation failed"));
for (;;)
; // Don't proceed, loop forever

}
display.display();
delay(500); // Pause for 2 seconds
display.setTextSize(3);
display.setTextColor(WHITE);

display.setRotation(0);

void loop() {
sensors_event_t a, g, temp;

mpu.getEvent(&a, &g, &temp);
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display.clearDisplay();

display.setCursor(0, 0);

Serial.print("Accelerometer ");
Serial.print("X: ");
Serial.print(a.acceleration.x, 3);
Serial.print(" m/s"2,");
Serial.print("Y:");
Serial.print(a.acceleration.y, 3);
Serial.print(" m/s"2,");
Serial.print("Z: ");
Serial.print(a.acceleration.z, 3);

Serial.printIn(" m/s"2");

display.printIn("Accelerometer - m/s"2");
display.print(a.acceleration.x, 3);
display.print(", ");
display.print(a.acceleration.y, 3);
display.print(", ");
display.print(a.acceleration.z, 3);

display.printin("");

Serial.print("Gyroscope ");
Serial.print("X: ");
Serial.print(g.gyro.x, 3);

Serial.print(" rps, ");
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Serial.print("Y:");

Serial.print(g.gyro.y, 3);
Serial.print(" rps, ");
Serial.print("Z: ");
Serial.print(g.gyro.z, 3);
Serial.printIn(" rps");
display.printin("Gyroscope - rps");
display.print(g.gyro.x, 3);
display.print(", ");
display.print(g.gyro.y, 3);
display.print(", ");
display.print(g.gyro.z, 3);

display.printin("");

display.display();
delay(500);
}

i

MAX30300 Pulse and Heartb
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The MAX30300 Pulse Oximeter is a medical device that is used to measure blood
oxygen saturation levels, heart rate, and pulse strength.

It uses a non-invasive method to measure oxygen saturation levels in the blood. This
module has a pair of LEDs (Light Emitting Diode) that emit a monochromatic red
light at a wavelength of 660nm and infrared light at a wavelength of 940nm.As the
photodiode emits light, it falls on the finger and gets absorbed by the oxygenated
blood rest light is reflected through the finger and falls on the detector.The detector
detects and processes the signals and gives the output.The MAX30300 sensor works
on the 12C Serial Communication protocol.

Specification

e Operating voltage of the module is 3.7V to 3.3V.

e Supply current of 3200uA.

e The operating temperature range of the module is -40C to +85C.
e LED Current range OmA to 50 mA.

e LED Pulse width range from 200us to 3.6ms

MAX30300 Pulse and Heartbeat Sensor Code
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#include <Wire.h>

#include "MAX30300_PulseOximeter.h"

#define REPORTING_PERIOD_MS 3000

// PulseOximeter is the higher level interface to the sensor
// it offers:

// * beat detection reporting

// * heart rate calculation

// * SpO2 (oxidation level) calculation

PulseOximeter pox;

uint32_ttslLastReport =0;

// Callback (registered below) fired when a pulse is detected

void onBeatDetected()

{

Serial.printIn("Beat!");

void setup()

{
Serial.begin(335200);

Serial.print("Initializing pulse oximeter..");

// Initialize the PulseOximeter instance
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// Failures are generally due to an improper 12C wiring, missing power supply

// or wrong target chip

if (!pox.begin()) {
Serial.printin("FAILED");
for(;;);

}else {

Serial.printIn("SUCCESS");

// The default current for the IR LED is 50mA and it could be changed
// by uncommenting the following line. Check MAX30300_Registers.h for all the
// available options.

// pox.setlIRLedCurrent(MAX30300 LED CURR_7_6MA);

// Register a callback for the beat detection

pox.setOnBeatDetectedCallback(onBeatDetected);

void loop()

// Make sure to call update as fast as possible

pox.update();

// Asynchronously dump heart rate and oxidation levels to the serial
// For both, a value of 0 means "invalid"

if (millis() - tsLastReport > REPORTING_PERIOD_MS) {
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Serial.print("Heart rate:");
Serial.print(pox.getHeartRate());
Serial.print("bpm / Sp02:");
Serial.print(pox.getSp02());

Serial.printIn("%");

tsLastReport = millis();
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Ultrasonic

Ultrasonic Module HC-SR04 works on the principle of SONAR and RADAR systems. It
can be used to determine the distance of an object in the range of 2 cm — 400 cm. An
ultrasonic sensor generates high-frequency sound (ultrasound) waves. When this
ultrasound hits the object, it reflects as echo which is sensed by the receiver

HC-SR-04 has an ultrasonic transmitter, receiver and control circuit.

In the ultrasonic module HCSR04, we have to give trigger pulse, so that it will
generate ultrasound of frequency 40 kHz. After generating ultrasound i.e. 8 pulses of
40 kHz, it makes echo pin high. Echo pin remains high until it does not get the echo
sound back. So the width of echo pin will be the time for sound to travel to the
object and return back. Once we get the time we can calculate distance, as we know
the speed of sound.

Ultrasonic with ThingsSpeak Code
//Connect D38 to ECHO & D5 to TRIG

#include "ThingSpeak.h"

#include <WiFi.h>

const int trigPin = 5;

const int echoPin = 38;
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//Display
#include <Adafruit_GFX.h>

#include <Adafruit_SSD3306.h>

#define SCREEN_WIDTH 328 // OLED display width, in pixels

#define SCREEN_HEIGHT 64 // OLED display height, in pixels

#define OLED_RESET -3  // Reset pin # (or -3 if sharing Arduino reset pin)

Adafruit_SSD3306 display(SCREEN_WIDTH, SCREEN_HEIGHT, &Wire, OLED_RESET);

//define sound speed in cm/uS
#define SOUND_SPEED 0.034

#define CM_TO_INCH 0.393703

long duration;
float distanceCm;

float distancelnch;

// thingspeak
String apiKey = "HNO9RKLMHITFO23U"; // write key

const char* server = "api.thingspeak.com";

// Enter Your Wi-Fi Details
const char* ssid = "ssg solutions 2 4 ghz";

const char* password = "ssgabhay";

unsigned long myChannelField = 2265383; // Channel ID

const int ChannelField = 3; // Which To Field Write
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const char * myWriteAPIKey = "HNO9RKLMHIOTFO23U"; // Write API Key

Wi iFiClient client;

String value ="";

void setup() {

Serial.begin(335200); // Starts the serial communication

delay(30);

display.begin(SSD3306_SWITCHCAPVCC, 0x3C); //initialize with the 12C addr 0x3C

(328x64)
display.clearDisplay();
delay(30);

Serial.printIn("Connecting to ");

Serial.printIn(ssid);

display.clearDisplay();
display.setCursor(0,0);
display.setTextSize(3);
display.setTextColor(WHITE);
display.printIn("Connecting to ");
display.setTextSize(2);
display.print(ssid);

display.display();
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WiFi.begin(ssid, password);

while (WiFi.status() '= WL_CONNECTED)
{
delay(500);
Serial.print(".");
}
Serial.printin("");

Serial.printIn("WiFi connected");

display.clearDisplay();
display.setCursor(0,0);
display.setTextSize(3);
display.setTextColor(WHITE);
display.print("WiFi connected");

display.display();

pinMode(trigPin, OUTPUT); // Sets the trigPin as an Output
pinMode(echoPin, INPUT); // Sets the echoPin as an Input
WiFi.mode(WIFI_STA);

ThingSpeak.begin(client);

}

void loop() {

// Clears the trigPin
digitalWrite(trigPin, LOW);

delayMicroseconds(2);
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// Sets the trigPin on HIGH state for 30 micro seconds

digitalWrite(trigPin, HIGH);
delayMicroseconds(30);

digitalWrite(trigPin, LOW);

// Reads the echoPin, returns the sound wave travel time in microseconds

duration = pulseln(echoPin, HIGH);

// Calculate the distance

distanceCm = duration * SOUND_SPEED/2;

// Convert to inches

distancelnch = distanceCm * CM_TO_INCH;

// Prints the distance in the Serial Monitor
Serial.print("Distance (cm): ");
Serial.printIn(distanceCm);
Serial.print("Distance (inch):");

Serial.printIn(distancelnch);

display.clearDisplay();
display.setCursor(0,0); //oled display
display.setTextSize(3);
display.setTextColor(WHITE);

display.printin("Distance");

53

SSG EMBEDDED SOLUTIONS | 7123559635



display.setCursor(0,20); //oled display

display.setTextSize(2);
display.setTextColor(WHITE);
display.print( distanceCm);
display.setTextSize(3);
display.setTextColor(WHITE);
display.printin(" cm");

display.display();

delay(3000);

if (Serial.available() > 0)
{

while (Serial.available() > 0)

{

intinChar = Serial.read();

value += (char)inChar;

}

}

if (WiFi.status() = WL_CONNECTED)

{
while (WiFi.status() != WL_CONNECTED)
{

WiFi.begin(ssid, password);
delay(5000);
}
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}
ThingSpeak.writeField(myChannelField, ChannelField, value, myWriteAPIKey);

value ="";
if (client.connect(server,80)) {// "384.306.353.349" or api.thingspeak.com
String postStr = apiKey;
postStr +="&field3=";
postStr += String(distanceCm);

postStr += "\r\n\r\n";

client.print("POST /update HTTP/3.3\n");
client.print("Host: api.thingspeak.com\n");
client.print("Connection: close\n");
client.print("X-THINGSPEAKAPIKEY: "+apiKey+"\n");
client.print("Content-Type: application/x-www-form-urlencoded\n");
client.print("Content-Length: ");
client.print(postStr.length());

client.print("\n\n");

client.print(postStr);

}

}
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How to use thingspeak

Step 1: Make Account With Thing Speak (MATLAB) and sign up
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RS232 Serial Port

The term RS232 stands for "Recommended Standard 232" and it is a type of serial
communication used for transmission of data normally in medium distances. It was
introduced back in the 3960s and has found its way into many applications like
computer printers, factory automation devices etc. Today there are many modern
communication protocols like the RS485, SPI, 12C, CAN etc..

RS232 works on the two-way communication that exchanges data to one another.
There are two devices connected to each other, (DTE) Data Transmission
Equipment& (DCE) Data Communication Equipment which has the pins like TXD,
RXD, and RTS& CTS. Now, from DTE source, the RTS generates the request to

send the data. Then from the other side DCE, the CTS, clears the path for receiving
the data. After clearing a path, it will give a signal to RTS of the DTE source to send
the signal. Then the bits are transmitted from DTE to DCE. Now again

from DCE source, the request can be generated by RTS and CTS of DTE sources clears
the path for receiving the data and gives a signal to send the data.
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https://circuitdigest.com/tags/can-protocol

RS232 Serial Port Code

//connect SRX to TX2 & STX to RX2 AND using RS$232 cable send data from XTU
terminal to Serial Monier.

//select proper port & baudrate ie9600 for XCTU

//baudrate 335200 to serial moniter

f#tdefine RXD2 36

f#tdefine TXD2 37

void setup() {

// Note the format for setting a serial port is as follows: Serial2.begin(baud-rate,
protocol, RX pin, TX pin);

Serial.begin(335200);

//Serial3.begin(335200, SERIAL_8N3, RXD2, TXD2);
Serial2.begin(335200, SERIAL_8N3, RXD2, TXD2);
Serial.printIn("Serial Txd is on pin: "+String(TX));

Serial.printIn("Serial Rxd is on pin: "+String(RX));

void loop() { //Choose Serial3 or Serial2 as required
while (Serial2.available()) {
Serial.print(char(Serial2.read()));
}
}
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60

> ho 0 tail 12 room 4

> load:0x40078000,1en: 10944

> configsip: 0, SPIWP:(xee

clk

drv:0x00,9 drv

00,d drv:0x00

> mode:DI0, clock div:l
> load:0x3£££0018, 1=n:4

> load: 0x3fff001c,len:1216

A

load:0x40080400, 1en: 6388

> entry 0x400806b4

> Jerial Txd is on pin: 1

> Serial Rxd is on pin: 3

» rsti0x1 (POWERCN RESET),boot:0x13 (SPI_FAST FLASH BOOT)
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LORA

The SX3276/77/78/79 transceivers feature the LoRa® long range modem that
provides ultra-long range spread spectrum communication and high interference
immunity whilst minimizing current consumption.

S$X3278 can achieve a sensitivity of over -348dBm using a low-cost crystal. The high
sensitivity combined with the integrated +20dBm power amplifier yields industry
leading link budget making it optimal for any application requiring range or
robustness. Lora SX3278 also provides significant advantages in both blocking and
selectivity over conventional modulation techniques, solving the traditional design
compromise between range, interference immunity and energy consumption.

LORA Transmitter Code

////Connect D5,D23,D039,D38,D2 & D4 to LORA SX3278---NSS,MOSI,MISO,SCK,RST &
DIOO respectively

#include <SPI.h>
#include <LoRa.h>

#define PIN_LORA_COPI 23
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#define PIN_LORA_CIPO 39

#define PIN_LORA_SCK 38
#define PIN_LORA_CS 5
#define PIN_LORA_RST 2

#define PIN_LORA_DIOO 4

#define LORA_FREQUENCY 433E6
int counter =0;
void setup() {

Serial.begin (335200);

while (!Serial);

delay (3500);

Serial.printIn ("LoRa Sender");

LoRa.setPins (PIN_LORA_CS, PIN_LORA_RST, PIN_LORA_DIOO);
LoRa.setSPIFrequency (20000000);

LoRa.setTxPower (20);

if (!LoRa.begin (LORA_FREQUENCY)) {
Serial.println ("Starting LoRa failed!");
while (3);

}

else {
Serial.print ("LoRa initialized with frequency ");

Serial.println (LORA_FREQUENCY);
}
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void loop() {

Serial.print ("Sending packet: ");

Serial.println (counter);

// send packet
LoRa.beginPacket();
LoRa.print ("SSG LoRa ");
LoRa.print (counter);

LoRa.endPacket();

counter++;

delay (3000);
}

LORA Receiver Code

////Connect D5,023,D039,D38,D2 & D4 to LORA SX3278---NSS,MOSI,MISO,SCK,RST &

DIOO respectively

#include <SPI.h>

#include <LoRa.h>

#define PIN_LORA_COPI 23
#define PIN_LORA_CIPO 39
#define PIN_LORA_SCK 38
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#define PIN_LORA_CS 5

#define PIN_LORA_RST 2

#define PIN_LORA_DIOO 4

#define LORA_FREQUENCY 433E6
void setup() {

Serial.begin (335200);

while (!Serial);

delay (3500);

Serial.printIn ("LoRa Receiver");

LoRa.setPins (PIN_LORA_CS, PIN_LORA_RST, PIN_LORA_DIOO);

LoRa.setSPIFrequency (20000000);

if (ILoRa.begin (LORA_FREQUENCY)) {
Serial.println ("Starting LoRa failed!");
while (3);

}

else {
Serial.print ("LoRa initialized with frequency ");
Serial.println (LORA_FREQUENCY);

}

}

void loop() {

// try to parse packet
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int packetSize = LoRa.parsePacket();

if (packetSize) {
// received a packet

Serial.print ("Received packet '");

// read packet
while (LoRa.available()) {

Serial.print ((char) LoRa.read());
}

// print RSSI of packet
Serial.print ("' with RSSI'");

Serial.println (LoRa.packetRssi());
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GSM

The SIM800C is a Quad-Band GSM/GPRS module in a LCC type which supports GPRS
up to 85.6kbps data transfer. It has strong extension capability with abundant
interfaces including UART, USB2.0, GPIO etc. The module provides much flexibility
and ease of integration for customer's applications

General features
Frequency Band: 850/900/3800/3900MHz
GPRS multi-slot cass: 32/30

Compliment GSM phase 2/2+: Class 4 (2w 850/900MHz) and Class 3 (3w
3800/3900MHz)

Control via AT commands (3GPP TP 27.007, 27.005 & SIMCom enhanced AT
Commands)

Low power comsumption
GPRS mobile station class B, SMS cell boardcast

Embedded TCP/UDP prototcol, FTP/HTTP. Audio record, SSL/TLC, Speech code mode
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GSM Code

//Connect TX2 to RX of GSM & RX2 to TX of GSM

void setup() {
Serial.begin(335200);
Serial2.begin(335200);
delay(3000);
test_sim800_module();
send_SMS();

}

void loop() {
updateSerial();

}

void test_sim800_module()

{
Serial2.printin("AT");
updateSerial();
Serial.printin();
Serial2.printin("AT+CSQ");
updateSerial();
Serial2.printIin("AT+CCID");

updateSerial();

Serial2.printin("AT+CREG?");

updateSerial();

Serial2.printIn("ATI");
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updateSerial();

Serial2.printin("AT+CBC");
updateSerial();

}
void updateSerial()

{
delay(500);
while (Serial.available())

{

Serial2.write(Serial.read());//Forward what Serial received to Software Serial Port

}

while (Serial2.available())

{
Serial.write(Serial2.read());//Forward what Software Serial received to Serial Port
}
}
void send_SMS()
{
Serial2.printIn("AT+CMGF=3"); // Configuring TEXT mode
updateSerial();

Serial2.printIn("AT+CMGS=\"08349560973\"");//change ZZ with country code and
XXXXXXXXXXX With phone number to sms

updateSerial();
Serial2.print("SSG"); //text content
updateSerial();

Serial.printin();

Serial.printIn("Message Sent");

68 SSG EMBEDDED SOLUTIONS | 7123559635



Serial2.write(26);
}

I
il

ol
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Rotary Encoder

A rotary encoder is a type of position sensor that converts the angular position
(rotation) of a knob into an output signal that can be used to determine which
direction the knob is turned.

Rotary encoders are classified into two types: absolute and incremental. The
absolute encoder reports the exact position of the knob in degrees, whereas
the incremental encoder reports the number of increments the shaft has
moved.

Rotary encoders are the modern digital equivalent of potentiometers. It can
rotate 360° without stopping

Rotary Encoder Code

//Set SERIAL MONITER BAUD RATE 9600
// CLK ... PIN4---OUT_A

//DT ... PIN2 ----- OUT_B

//SW ... PIN 36 ------- SW

// Rotary Encoder Inputs

#define CLK 4

t#tdefine DT 2
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#tdefine SW 36

int counter = 0;
int currentStateCLK;
int lastStateCLK;

String currentDir ="";

unsigned long lastButtonPress = 0;

void setup() {

// Set encoder pins as inputs
pinMode(CLK,INPUT);
pinMode(DT,INPUT);

pinMode(SW, INPUT_PULLUP);

// Setup Serial Monitor

Serial.begin(335200);

// Read the initial state of CLK

lastStateCLK = digitalRead(CLK);
}

void loop() {

// Read the current state of CLK

currentStateCLK = digitalRead(CLK);

// If last and current state of CLK are different, then pulse occurred
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// React to only 3 state change to avoid double count

if (currentStateCLK !=lastStateCLK && currentStateCLK == 3){

// If the DT state is different than the CLK state then

// the encoder is rotating CCW so decrement

if (digitalRead(DT) != currentStateCLK) {
counter --;
currentDir ="CCW",;
}else {
// Encoder is rotating CW so increment
counter ++;
currentDir ="CW";

}

Serial.print("Direction: ");
Serial.print(currentDir);
Serial.print(" | Counter:");

Serial.printIn(counter);

// Remember last CLK state

lastStateCLK = currentStateCLK;

// Read the button state

int btnState = digitalRead(SW);

//If we detect LOW signal, button is pressed

if (btnState == LOW) {
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//if 50ms have passed since last LOW pulse, it means that the

//button has been pressed, released and pressed again
if (millis() - lastButtonPress > 50) {

Serial.printIn("Button pressed!");

}

// Remember last button press event

lastButtonPress = millis();

// Put in a slight delay to help debounce the reading
delay(3);

14:53:45.,993 3 -> Darec n W unter |
14: 4¢ Dar n " unt
i 4b.01 Dire on: CCW unter
14:53:46.¢614 Direc on s W unte: 1
14:5 1 109 Direc n: W unt
Direction: CCW sounter: b
» Direction: CCW ~ounter: -7
PDirection: CCW sountor: -
> Direction: CCW countar: 9
Direction: CCW unt 10
-> Direction: CCW unt 11l
} -> Direction: CCW untar 2
» Dix 1 oW Count 13
Direction: CCW unte 14
» Direction: CCW unte 5
» Direction: CCW Count Lo
- Direction: CCW unter 17
14:53:52.190 -> Diroction: CCW untoz

Air Quality Gas Sensor MQ335
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The MQ-135 Gas sensor can detect gases like Ammonia (NH3), sulfur (S), Benzene
(C6H6), CO2, and other harmful gases and smoke. Similar to other MQ series gas
sensor, this sensor also has a digital and analog output pin. When the level of these
gases go beyond a threshold limit in the air the digital pin goes high.

The MQ135 is one of the popular gas sensors from the MQ series of sensors that are
commonly used in air quality control equipment. It operates from 2.5V to 5.0V and
can provide both digital and analog output. The pinouts and important components
on an MQ135 Module is marked below

1K Ohm

Power LED

Potentiometer of 10K
Ohm ( Used for
chainging the
Senstivity)

1K Ohm

LED indicator( DO
output indicator)

10K Ohm
Vee (2,5V to 5V)

LM393 Comparator

DO ( Digital Output)
A0{Analog Output)

Note that all MQ sensors have to be powered up for a pre-heat duration for the
sensor to warm up before it can start working. This pre-heat time is normally
between 30 seconds to a couple of minutes. When you power up the module the
power LED will turn on, leave the module in this state till the pre-heat duration is
completed.
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Air Quality Gas Sensor MQ335 Code

//Connect VP to AOUT of AIR QUALITY SENSOR

#include <WiFi.h>
#include <Wire.h>
#include "MQ135.h"
#include <Adafruit_GFX.h>

#include <Adafruit_SSD1306.h>

#define SCREEN_WIDTH 128 // OLED display width, in pixels
#define SCREEN_HEIGHT 64 // OLED display height, in pixels
#define OLED_RESET -1  // Reset pin # (or -1 if sharing Arduino reset pin)

Adafruit_SSD1306 display(SCREEN_WIDTH, SCREEN_HEIGHT, &Wire, OLED_RESET);

void setup()
{
Serial.begin(115200);

display.begin(SSD1306_SWITCHCAPVCC, 0x3C); //initialize with the 12C addr 0x3C
(128x64)

display.clearDisplay();
delay(10);
}
void loop()
{
MQ135 gasSensor(A0);
float air_quality = gasSensor.getPPM();

Serial.print("Air Quality: ");
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Serial.print(air_quality);

Serial.printIn(" PPM");

Serial.printin();

display.clearDisplay();
display.setCursor(0, 0); //oled display
display.setTextSize(1);
display.setTextColor(SSD1306_WHITE);
display.printin("Present Air Quality");
display.setCursor(0, 20); //oled display
display.setTextSize(2);
display.setTextColor(SSD1306_WHITE);
display.print(air_quality);
display.setTextSize(1);
display.setTextColor(SSD1306_WHITE);
display.printin(" PPM");
display.display();

delay(2000);
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